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Foreword 

*(Please read before starting this document) 

  

   
   
Description of 

the example 
The goal of this technical example is to demonstrate the ability and 

advantage of Flux for the simulation of a skewed induction motor 

computation problems. This document contains the general steps and all the 

data needed to describe the different simulations. 

 

   
   
To begin This example is designed for the user who is already familiar with the basic 

functions of Flux software. 

For beginner users, please report to the “Flux Starting Guide” opened 

automatically by the supervisor. (If not opened, please open it by clicking on 

the button “?” on the top right of the supervisor). The interface contains 

videos, which helps the beginners while using Flux for the first time 

 

   

   
Support files 

included... 
To view the completed phases of the example project, the user will find the 

.py files, including the geometry, physics and post processing descriptions. 

The .py files corresponding to the different study cases in this example are 

available in the folder: 

…\DocExamples\Examples2D\InductionMotor_SKEW\ 

Supplied files are command files written in Pyflux language. The user can 

launch them in order to automatically recover the Flux projects for each 

case. 

**(.py files are launched by accessing Project/Command file from the Flux 

drop down menu.) 

 

 Supplied files Contents .FLU file obtained 

after launching 

 the .py file 

 

 

CASE1 

buildGeomesh.py Geometry and mesh Geomeshbuilt.FLU  

 buildPhys.py physics BuiltPhys.FLU  

 solving.py Solving process Solved.FLU  

 postprocessing.py Post processing Postprocessed.FLU  

 
 

    

CASE2 

TestCase_INI.FLU Initial Flux project   

 solving.py Solving process Solved.FLU  

 postprocessing.py Post processing Postprocessed.FLU  

 
 

    

CASE3 

TestCase_INI.FLU Initial Flux project   

 buildPhys.py physics BuiltPhys.FLU  

 solving.py Solving process Solved.FLU  

 postprocessing.py Post processing Postprocessed.FLU  

 
 

     

Note : some directories may contain a main.py enabling the launch of the other 

command files 
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1. General information 

 
Introduction The goal of this technical paper is to demonstrate Flux capabilities in 

modeling an induction machine with a skewed rotor. This chapter presents the 

studied device, (an induction machine with a skewed rotor) and explains the 

strategies used for geometry construction and mesh generation. 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Overview 3 

Strategy to build the Flux project 7 

About the Overlay (motor template) 9 
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1.1. Overview 

 
Introduction This section is an overview of the sample problem. It contains a brief 

description of the device and of the studied cases. 

 
Contents This section contains the following topics: 

 

Topic See Page 

Description of the device 4 

Studied cases 6 
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1.1.1. Description of the device 

 
Foreword This paragraph is a summary of cases treated in detail in the Skew example: 

"Induction Skewed motor technical paper". 

The files relating to the studied cases are available in the documentation 

directory of the Flux DVD. 

  

 
Studied device The studied device is  a 4 poles induction skewed motor presented in the 

figure below, includes the following elements:  

• a fixed part (stator) including yoke, slots, and windings 

• an air gap 

• a movable part (rotor) with skewed slots. 

A section of the model of the studied device is presented in the figure below. 
  

 

Figure 0-1 

View of the  induction motor calculated with Flux 

  
Motor ratings This motor has the following main ratings : 

• Rated power : 5.5 kW 

• Power supply voltage : 400 V. 

• cos φ  = 0.78 

• Rated current : 11.9A 

• Speed : 1471.5 rpm 

Continued on next page 
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Geometric 

characteristics  
This motor has the following geometric characteristic : 

• Stator external diameter : 168 mm 

• Cylinder bore diameter : 110 mm 

• Airgap thickness : 0.4 mm 

• Rotor external diameter : 109.2 mm 

• Shaft diameter : 33 mm 

• Number of stator slots : 48 

• Number of rotor bars : 28 

• Number of pairs of poles : 2 

• Stator length : 140 mm 

 
Motor winding 

characteristics 
This motor has the following winding characteristics :  

• Type of winding Concentric with consequent poles 

• Number of slots per pole and per phase : 4 

• Number of turns in series per phase : 80 

• Diameter of a spire : 0.8 mm 

• Number of windings in parallel per phase : 1 

• Throw : 0 to 15 

 
Material  Material used are :  

• Material of the rotor and the stator : M1000-65D 

• Material of the squirrel cage : Copper 
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1.1.2. Studied cases 

 
Studied cases Fhree cases are studied in this technical paper: 

• Case 1: Steady State at no load 

• Case 2: Steady State study to compute the characteristics of the machine at 

rated Speed 

• Case 3: Transient study at no load 

 
Case 1 The first case is a steady state magnetic AC study. 

Steady state simulation of no load operation of the motor in order to evaluate 

stator current at no load.  

 
Case 2 The second case is a steady state magnetic AC study. 

This study is a parameterized magneto-harmonic analysis with values of rotor 

slip in order to evaluate the motor characteristics for rated load operation and 

display torque and current versus slip curves. 

 
Case 3 The third case is a transient study. 

This study is a transient simulation at no load. Stator current and torque are 

computed and display versus time. At steady state; values must be similar to 

the values calculated with the case 1. 
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1.2. Strategy to build the Flux project 

 
Introduction An outline of the strategy employed to model the geometry and mesh 

description of the motor is presented in the table below. 

 

Stage Description 

1 
Description of the motor 

geometry using an overlay 

• Load an overlay 

• Modify the overlay 

2 Meshing of the device • Mesh 

 
Theoretical 

aspect 
The basic knowledge necessary to describe a motor is provided by utilizing an 

overlay and is presented in the following section. 
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1.3. About the Overlay (motor template) 

  
Introduction This section deals with the Induction Motor Template and answers the 

following three questions: 

• What is possible to model with Flux? (presentation of the object editor, 

available library) 

• How to describe the problem in Flux? (use the object editor) 

• What are the possible links with Speed? 

 
Contents This section contains the following topics: 

 

Topic See Page 

Motor Template: presentation 10 

Motor Template: the library 11 

Motor Template: principle of description in Flux 12 

Motor Object: Speed importation 13 
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1.3.1. Motor Template: presentation 

  
Presentation The complete description of a motor in Flux can be somewhat long and 

involved. 

To describe a motor utilizing the standard Flux interface, the user must: 

• prepare the tools of geometric description (parameters, coordinate systems, 

…) 

• create the points and lines of the rotor and stator (slots, air-gap, …) 

• build the faces  

• mesh the device  

• create the regions and assign to faces  

• … 

These different stages must be repeated for each type of motor that is being 

modeled. 

Now it is possible for Flux to simplify this process, by providing a library of 

predefined motor templates. 

With this new description mode, the stages of model construction are 

simplified. The user chooses a type of motor and winding from the library and 

interactively enters the parameters of the motor.  

  
Motor object: 

definition 
An Induction Motor template is an object from the specific library: 

• Induction Motor 

This covers information related to geometry and mesh. There is no 

information about physics. 
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1.3.2. Motor Template: the library 

  
Introduction The library of Motor objects is a library of motors with induction motors 

The models are standard ones. This library corresponds to the one provided in 

the Speed software. 

  
List of models  The different models in the library are not detailed in the on line help because 

their documentation is included in the software. An interactive image is 

displayed in the object editor. The editor displays a direct visualization of the 

parameters entered by the user. 

The list of models provided for  the  stator is presented in the table below. 

  

Rotor Stator 

Single Cage StatorAirGapWdg 

Double Cage StatorFlared 

 StatorGH 

 StatorGolfTee 

 StatorHW 

 StatorPllHW 

 StatorPIIRound 

 StatorPIISlot 

 StatorPIISquare 

 StatorPIISquareWedged 

 StatorRound 

 StatorSquare 

 StatorVarDeth 

  

  

  

 
Example  An example of motor template is presented in the figures below. 

Rotor Induction 

Machine 

(double cage) 

Stator 

(12 slots) 
Whole motor 
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1.3.3. Motor Template: principle of description in Flux 

  
General 

operation  
The template editor provided in Flux is an “assistant to the creation of the 

model” which is part of the overall construction process of a finite element 

project. The motor template editor simplifies the stage of the geometry 

construction and the mesh building as shown in the table below.   

 

Stage “Standard” description  “Assisted” description 

1 Geometry building  
 

 

Direct construction of a 

meshed motor  2 Mesh construction  

3 Physical properties description 
 

 

Identical 
4 Solving process 

5 
Results post-processing 

  
Principle The user builds the motor directly in Flux using the template editor and the 

induction motor Object library. 

The general principle of operation is given in the table below. 

 

Stage The user provides … Flux carries out … 

1 

Geometric characteristics: 

• general: 

units / … 

• of stator : 

shape / dimension /number of slots /  

• of rotor : 

shape / dimension / number of poles /  

Choices for FE modeling:  

• taking periodicities  into account  

• influence of  eccentricities    

Geometry building: 

• creation of parameters, coordinate 

systems, transformations    

• creation of points, lines, faces  

Grouping of the faces in regions  

• creation of regions : shaft, rotor, stator, 

magnet, air-gap, air         

• assigning of the regions to faces  

2 

A coefficient to adjust the mesh density 

(value comprised between 0.5 and 1)      

Mesh construction: 

• automatic mesh and  

linked mesh to faces      

3 

Winding characteristics:  

• Distribution of the phases in the slots: 

“standard” winding or particular 

winding 

Grouping of the faces in regions (continued) 

• Creation of regions corresponding to the 

coils (grouping by phase)   

• Assigning of the regions to faces  

 
…to continue  The user continues the description of the finite element project in the usual 

way: description of the physical properties, creation of the mechanical 

assemblies, description of the electric circuit and importing it into Flux, 

solving and post-processing of the results.  
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1.3.4. Motor Object: Speed importation 

 
Introduction The Flux/Speed link is created by the introduction in Flux of an Induction 

object from the Speed library. 

 
Speed 

Importation  
The user can import a motor described with Speed (Speed file) into Flux. The 

Speed/Flux compatibility makes this possible. All the information concerning 

the geometric characteristics and the winding characteristics are preserved 

(dimensional parameters*, number of poles, of phases, …). 
 

*The name of the parameters are the same in Speed and Flux 
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2. Geometry and mesh description of the motor 

 

 
New Flux 

project 
The new Flux project is saved under the name GEOMESH.FLU (CASE0). 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Load the Induction Motor overlay 15 

Create an induction motor using the overlay 19 

Modify mesh point and mesh the device 23 
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2.1. Load the Induction Motor overlay 

 
Goal First, the geometry and mesh is carried out utilizing an overlay. 

 
Action (1) Close the sketcher2D context. 

 

 Project → Close Sketcher2D context 
 

 
Action (2) Load the INDUCTION_MOTORS_V11.1.PFO overlay. 

 

 Extensions → Overlay → Load a certified overlay  

 



Geometry and mesh description of the motor  Flux 

PAGE 18 Induction motor with Skew tutorial  



Flux  Geometry and mesh description of the motor 

Induction motor with Skew tutorial PAGE 19 

2.2. Create an induction motor using the overlay 

 
Goal The geometry of the motor is described using an overlay. 

 
Action From the data tree, create a new Induction motor. 
 

 
 

 

 
Data (1) The general characteristics of the motor are presented in the tables below. 

 
General description 

 
Length unit Mesh density 

Infinite box 

Inner radius Outer radius 

Millimeter 0.5 110 140 

 
Airgap description 

 Air gap Eccentricities Rotating air gap Use periodicities 

0.4 no 2_layers_airgap yes 

 
Data (2) The characteristics of the rotor are presented in the tables below. 

 
Rotor description 

 
General description 

 
Rotor external 

radius 
Number of poles Shaft radius 

Rotor shift angle 

[Deg] 

54.6 4 16.5 0.0 

 
Cooling holes 

 1. Without cooling holes 

 
Cage 

 1 – Single cage  

 
Bars shape 

 

Type 0 

Bridge 
Rotor slot 

depth 

Rotor tooth 

width 

Rotor tang 

angle 

0.2 21.8 4.908 30.0 

 

Number of bars : 
 

28 

Continued on next page 
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Data (3) The characteristics of the stator are presented in the tables below. 

 
Stator description 

 Slot shape description : Stator flared 

 General description 

Slot 

Depth 

Stator 

tooth 

width  

Slot 

Opening 

Radial 

depth 

Under

cut 

angle 

Slot width 

inside 

tooth tang 

filSO filSB 

14.5 3.0 2.8 0.62 41.5 3.53 0.4 1.85 

 
General description 

 Number of 

slots 

Stator 

configuration  
LamShape  

Stator outer 

radius  
Stator angle 

48 normal circle  84 0.0 

  
Data (4) The characteristics of the winding are presented in the tables below. 

 
Winding description 

 

Winding 
Number 

of phases 

Classical 

winding type 
Throw 

Number of 

coils per pole 

per phase 

Coils position 

in slot in case 

of two layers 

Classical 

winding 
3 

Concentric 

winding per 

pole 

15 4 superimposed 

 Continued on next page 
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Result The following motor is created with: 

• Part of the geometry 

• Part of the physics 

• Ready to be meshed 
 

 

  
Action Leave the overlay context. 
 

  
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2.3. Modify mesh point and mesh the device 

 
Goal  Mesh points will be edited and modified in order to improve the mesh. 

  
Data  The characteristics of the mesh points are presented in the table below. 

 
Mesh Point 

 Name  Value 

AIRGAP 

(((DMINSTATOR-

DMAXROTOR)/NB_REGION_IN_AIRGAP)*10**3

*LENGTH_UNIT)*2  

CAGE1_P2 
(1.5*MESH_CAGE1_P2/(1+MESH_FACTOR)*10**

3*LENGTH_UNIT)*4 

 

 Mesh → Mesh point → Edit  

 
Action (1) Mesh the device. 

  

 Mesh → Mesh domain 
 

 
Result The meshed device is presented in the figure below. 
 

 

 
Action (2) Save the project as GEOMESH.FLU. 

 

 Project → Save as    
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3. Case 1: Steady State - No load 

 
Case 1 The Flux2D magneto-harmonic simulations of the induction machine are 

performed for constant slip values (constant rotor speed values) and are 

problems that do not consider the rotor motion with respect to the stator. The 

current frequency in the rotor circuit is set at sf, where f is the motor supply 

frequency. 

 
Starting Flux 

project 
The starting project is the Flux project GEOMESH.FLU. This project 

contains: 

• the geometry description of the device 

• the mesh 

  
Project name The new Flux project is saved under the name of CASE1.FLU. 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Case 1: physical description process 27 

Case 1: solve the project 37 

Case 1: results post-processing 39 
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3.1. Case 1: physical description process 

 

  
Contents This section contains the following topics: 

 

Topic See Page 

Define the physical application  28 

Create materials 29 

Create I/O parameters  30 

Create mechanical sets 31 

Create a circuit 32 

Modify characteristics of electrical components 33 

Modify face regions 34 

Modify coil conductors face regions 35 
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3.1.1. Define the physical application 

  
Goal The physical application is defined. The required physical application is 

Rotating Induction Machine (Skewed Model) in Steady State AC 

Magnetic . 

  
Data  The characteristics of the application are presented in the table below. 

 

Rotating Induction Machine (Skewed Model) in Steady State AC Magnetic  

 Physical Definition 

Frequency in Hertz  50 
 

Geometric Definition 
 

Skewed rotor or 

stator 

Multilayer 

model 

Elevation 

in meter 

Angle of 

rotation in 

degrees  

Number of 

slices in the 

elevation 

Rotor with skewed 

slots 

Multilayers 

2D model 
0.14 10.23 5 

  

Coil Coeffcient 

 Automatic coefficient (Symmetry & Periodicity take into account) 

 

 
Application → Define → Magnetic → Rotating Induction Machine 
(Skewed Model) in Steady State AC Magnetic 
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3.1.2. Create materials 

  
Goal  Two materials are created in order to define the physics. 

 
Data (1) The magnetic characteristic ( )HB  of material comprising the stator and rotor 

areas is modeled by an isotropic scalar analytic saturation, with 2 coefficients  

 
Material 

 B(H) magnetic property: isotropic analytic saturation (arctg, 2 coef) 

Name 
Initial relative 

permeability 

Saturation 

Magnetization (T) 

Type of equivalent 

B(H) curve 

FEV_1000 1400 1.96 
Sine wave  

flux density 

  

 Physics → Material → New  

 
Data (2) The second material to be characterized is the copper (it is the material 

comprising the squirrel-cage and the stator winding). For the modeling we 

will assume it is purely resistive. The resistivity of pure copper at room 

temperature 20°C is: mCu .10.7241.1
8

20 =
−

 . 

Since the temperature coefficient of resistance of copper at 20°C is of 
310.93.3 −  per degree, the resistivity at another given temperature T can be 

found by the equation: 

( )  CuCuCu

T

Cu IACST −+= 201 2020   

where CuIACS  (97% in our case) is the International Annealed Copper 

Standard. 

Thus at 130° the resistivity of copper is 

mCu .10.39534.2
8

130 =
−

  

 

 
Material 

 

Name 

B(H) magnetic property: 

linear isotropic 

J(E) electrical property:  

isotropic resistivity 

Relative permeability Resistivity [Ohm.m] 

Copper 1 2.3953 e-8 

 

 Physics → Material → New  
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3.1.3. Create I/O parameters 

  
Goal One I/O parameter will be created in order to define the physics. 

 
Data (1) The characteristics of the I/O parameter defined by a formula are described in 

the table below. 

 
I/O parameter defined by a formula 

 Name  Comment Expression 

VRMS rms value of voltage source 400/Sqrt(3) 

  

 Parameter / Quantity  → I/O parameter → New  
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3.1.4. Create mechanical sets 

  
Goal  Two mechanical sets are created to define kinematic properties of the motor:  

• one mechanical set for the fixed part: the stator 

• one mechanical set for the moving part: the rotor 

  
Data The characteristics of the mechanical set are presented in the table below. 

 
Fixed mechanical set 

 Name Comment 

MS_STATOR Fixed part 

 
Rotation around one axis mechanical set 

 

Name Comment 

Axis Kinematics 

Rotation 

axis 

Coord. 

system 

Pivot point 

coordinates Type Slip 

1st 2nd 

MS_ 

ROTOR 

Moving 

part 

parallel 

to Z-axis 
XY1 0 0 Multi-static 0.001 

 

 Physics → Mechanical set → New  
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3.1.5. Create a circuit 

  

Goal  The goal is to define a circuit for this project. 

 

Data The circuit to be created is as follows: 

 

 
 

 Physics → Circuit → Circuit editor context 
 

 

Note: the coils and inductances are corresponding to the stator coils. A 

typical electric circuit associated with an induction machine reveals two parts 

electrically independent of each other but connected to establish a common 

ground: 

• one that describes the stator with voltage source, end winding resistances, 

inductances and stator’s coils 

• one that describes the rotor () with inter-bar end ring resistances and 

inductances and the rotor bars 

  

Action This circuit will also be used for case 3. For reusing this circuit, it is advisable 

to export it to xcir format with the name: InductionSkewedMotor.xcir  
 

 Circuit → Export circuit to a xcir file   

 

In the absence of recording, the circuit is saved by default under the project name: 

CASE1.xcir  

 

Action Close the circuit editor context. 

 

 Project → Return to standard geometry context 
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3.1.6. Modify characteristics of electrical components 

  
Goal  The circuit is modified in Flux in order to describe the physics. 

 
Data (1) The characteristics of voltage sources are described in the table below. 

 
Voltage source  

 Name  rms value [V] Phase [degree] 

V1 VRMS 0 

V2 VRMS -120 

V3 VRMS 120 

 

 Physics → Electrical components → Voltage source → Edit 

 
Data (2) The characteristics of the stranded coil conductors are described in the table 

below. 

 
Coil conductor belonging to a circuit 

 Name  Resistance formula [Ohm] 

B1, B2, B3 4*0.32392 = 1.29568 

 

 Physics → Electrical components → Coil conductor → Edit 

  
Data (3) The characteristics of the inductors are described in the table below. 

 
Inductor 

 Name  Inductance [Henry] 

L1, L2, L3 4*1.408.10-3 = 5.632e-3 

 

 Physics → Electrical components → Inductor → Edit 

 
Data (4) The characteristics of the squirrel cage are described in the table below. 

 

Components 
Number of 

bars 
R end ring L end ring 

SQUIRRELCAGE_1 7 4.7e-7  5.3e-9 H 

 

 Physics → Electrical components → Squirrel cage → Edit 
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3.1.7. Modify face regions 

  
Goal  Face region are edited and modified in order to describe the physics. 

  
Data The characteristics of the face regions used to describe the materials are 

presented in the tables below. 

  

Face region 

ypp Name Type  Material Mechanical set 

STATOR Magnetic non conducting  FEV_1000 MS_STATOR 

ROTOR Magnetic non conducting FEV_1000 MS_ROTOR 

 

Face region 

pp 

Name Type  

M
a

teria
l 

C
ircu

it / 

N
o

 circu
it 

Associated solid  

conductor 

O
rien

ta
tio

n
 

M
ech

a
n

ica
l 

set 

ROTOR_CAGE1

_BAR1 

Solid 

conductor 
Copper Circuit 

BAR_1_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR2 

Solid 

conductor 
Copper Circuit 

BAR_2_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR3 

Solid 

conductor 
Copper Circuit 

BAR_3_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR4 

Solid 

conductor 
Copper Circuit 

BAR_4_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR5 

Solid 

conductor 
Copper Circuit 

BAR_5_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR6 

Solid 

conductor 
Copper Circuit 

BAR_6_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1

_BAR7 

Solid 

conductor 
Copper Circuit 

BAR_7_SQUIRREL

CAGE_1 
Positive MS_ROTOR 

 
Face region 

 Name Type  Mechanical set 

INFINITE Air or Vacuum region MS_STATOR 

PRESLOT Air or Vacuum region MS_STATOR 

ROTATING_AIRGAP Air or Vacuum region MS_STATOR 

STATOR_AIR Air or Vacuum region MS_STATOR 

WEDGE Air or Vacuum region MS_STATOR 

ROTOR_AIR Air or Vacuum region MS_ROTOR 

SHAFT Air or Vacuum region MS_ROTOR 

 

 Physics → Face region → Edit   
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3.1.8. Modify coil conductors face regions 

  
Goal  Three face regions are modified in order to describe the physics. 

  
Data  The characteristics of the face regions are described in the table below. 

 
Face region 

 

Name Type  

C
o

m
p

o
n

en
t 

T
u

rn
 

n
u

m
b

er 

O
rien

ta
tio

n
 

S
y

m
m

etries 

a
n

d
 

p
erio

d
icities 

Mechanical 

set 

PHASE_POS_1 
Coil 

conductor 
B1 80 Positive 

All in 

series 
MS_STATOR 

PHASE_POS_2 
Coil 

conductor  
B2 80 Positive 

All in 

series 
MS_STATOR 

PHASE_NEG_3 
Coil 

conductor  
B3 80 Negative 

All in 

series 
MS_STATOR 

 

 Physics → Face region → Edit  

 
Action Check physics and save case 1. 

 

 Physics → Check Physics    

 

 Save Case1    
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3.2. Case 1: solve the project 

 

 
Goal  CASE1 project is solved using reference value. 

 
Action Solve and save the project under the following conditions: 

• Solve with: reference values 

• Project name: CASE1_SOLVED 

 

 Solving → Solve 
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3.3. Case 1: results post-processing 

 

  
Introduction This section explains how to analyze the principal results of CASE1. 

 
Contents This section contains the following topics: 

 

Topic See Page 

Display isovalues of the magnetic flux density on face regions 40 

Compute the stator current and torque at no load 41 
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3.3.1. Display isovalues of the magnetic flux density on face regions 

  
Goal The magnetic flux density is computed on the device (excluding vacuum 

regions) and isovalues are displayed in color shadings. 

 

Action Display isovalues (2_ISOVAL_NO_VACUUM) 

 

 Graphic → Isovalues → Display isovalues 
 

 
Result The following chart shows the isovalues of the magnetic flux density on the 

device.  
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3.3.2. Compute the stator current and torque at no load 

  
Goal The RMS stator current and torque are computed for the steady state case.  

 
Data The characteristics of the different computations are presented in the table 

below. 

 
Compute on physic entity  

 

Name 

Computed formula  

Electrical comp. Quantity 

Type Name Quantity Formula 

COMPUTE 

PHYSIC_1 

Coil 

conductor 

B1 Current – rms value [A] Mod(I(B1))/Sqrt(2) 

B2 Current – rms value [A] Mod(I(B2))/Sqrt(2) 

B3 Current – rms value [A] Mod(I(B3))/Sqrt(2) 

 
Name 

Computed formula  

Mechanical set Quantity Formula 

COMPUTE 

PHYSIC_1 
MS_ROTOR 

Electromagnetic 

torque 
TorqueElecMag(MS_ROTOR) 

 

 
Result The result of the computation is presented below. 

 

Computed formulas 
Results of computation 

Label Value  

Mod(I(B1))/Sqrt(2) Current – rms value [B1] 7.067 A 

Mod(I(B2))/Sqrt(2) Current – rms value [B2] 7.068A 

Mod(I(B3))/Sqrt(2) Current – rms value [B3] 7.067 A 

TorqueElecMag(MS_ROTOR) 
Mechanical set /  

magnetic torque [MS_ROTOR] 
2.0 N.m 

 
Action Do not forget to store the result of computation COMPUTEPHYSIC_1. 

 

 Computation → On  physical entity → Compute  
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4. Case 2: Full characteristics versus slip 

 
Case 2 The goal of this simulation is to obtain the main quantities of the machine as 

function of the slip. Results will be shown as a 2D plots with the slip as a 

varying parameter. The rated values are computed with a slip coefficient of 

0.0193 (~ 2%).  

 
Starting Flux 

project 
The starting project is the Flux project CASE1_SOLVED.FLU. This project 

contains: 

• the geometry description of the device 

• the mesh 

• the initial physical description of the motor 

• the case1 solved 

  
New project All the CASE1_SOLVED project results are deleted. The Flux project is then 

saved under the name of CASE2.FLU. 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Case 2: physical description process 45 

Case 2: solve the project 49 

Case 2: Results post-processing 51 
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4.1. Case 2: physical description process 

 

  
Contents This section contains the following topics: 

 

Topic See Page 

Create I/O parameters 46 

Modify a mechanical set 47 
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4.1.1. Create I/O parameters 

  
Goal One I/O parameter will be created in order to define the physics. 

 
Data (1) The characteristics of the I/O parameter defined via a scenario are described 

in the table below. 

 
I/O parameter controlled via a scenario 

 Name  Reference value 

SLIP 0.019 

  

 Parameter / Quantity  → I/O parameter → New  
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4.1.2. Modify a mechanical set 

 
Goal A mechanical set is modified to describe the physics.  

 
Data The characteristics of the mechanical set are described in the table below. 

 
Mechanical set of type: rotation around one axis  

 

Name Comment 

Axis Kinematics 

Rotation 

axis 

Coord. 

system 

Pivot point 

coordinates Type Slip 

1st 2nd 

MS_ 

ROTOR 

Moving 

part 

parallel 

to Z-axis 
XY1 0 0 Multi-static SLIP 

 

 Physics → Mechanical set → Edit  
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4.2. Case 2: solve the project 

 

 
Goal A solving scenario is created in order to solve CASE2. Then CASE2 is 

solved. 

 
Data The characteristics of the solving scenario used to solve the CASE 2 are 

presented in the tables below. 

 

Solving scenario 

 Name Comment 

CHARACTERISTICS Study using geometrical and physical parameter 

 
Solving scenario 

 Parameter control 

Controlled 

parameter 
Type 

Interval 

Lower 

limit 

Higher 

limit 
Method Value 

SLIP 
Multi-

values 
0.001 1.0 

List of 

steps 

0.001, 0.010, 0.012, 0.019, 

0.03, 0.05, 0.07, 0.09, 0.15, 

0.2, 0.3, 0.4, 0.6, 0.8, 1.0 

 

 Solving → Solving scenario → New  

 
Action Solve and save the project under the following conditions: 

• Solve with: solving scenario CHARACTERISTICS 

• Project name: CASE2_SOLVED 

 

 Solving → Solve 
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4.3. Case 2: Results post-processing 

 

 
Introduction This section explains how to analyze the principal results of CASE2. 

 
Contents This section contains the following topics: 

 

Topic See Page 

Create a sensor 52 

Load and run a macro to calculate the iron losses 53 

Create I/O parameter 55 

Steady state rated-load characteristics 57 

Power balance and efficiency for rated value 58 

2D Curve of the power balance 59 

Display isovalues of magnetic flux density 61 

Display isovalues of current density in rotor bars 62 
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4.3.1. Create a sensor  

 
Goal Create a sensor to calculate the stator joules losses in stator winding. 

 
Data The characteristics of the sensor are presented in the table below. 

 
Predefined sensor (Energy, Force, Torque): Losses by Joule effect 

 Name Comment Computation domain 

PJCS Stator joules losses Stranded coil conductor B1, B2, B3 

 

 Advanced  → Sensor → New  

 
Action Evaluate the sensor. 

 

 Advanced  → Sensor → Evaluate sensors  
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4.3.2. Load and run a macro to calculate the iron losses 

 
Goal Load and run a macro in order to calculate iron losses with Bertotti model, for 

each value of the variation parameter SLIP of the considered scenario.  

In the end, this macro create an I/O parameter “BertottiLosses” which can be 

used to make a power balance. 

 
Action (1) Load macro named BertottiIronLossesVsSlipAcImSk.PFM (located in the 

directory: Macros_FluxSkewed_Postproc) in the current project. 

 

 Project → Macro → Load  

  
Action (2) Run the macro. 

 

 In the Data Tree: Extensions → Macros → Run  

 
Data The computation of magnetic losses based on the flux density chart uses the 

following characteristics of laminations: 

• hysteresis losses coefficient kh = 363  Ws/T2m3  

• classical losses coefficient  = 4739300 -1m-1 

• losses in excess coefficient ke = 16.2 Ws1.5/m3/T1.5 

• thickness of laminations d = 0.65 mm  

• stacking factor kf = 0.97 

 

The characteristics of the macro (BertottiIronLossesVsSlipAcImSk.PFM) 

are presented below. 

 
BertottiIronLossesVsSlipAcIm.PFM 

 

Scenario 
Variation 

parameter 

Volume 

region 

Hysteres

is losses 

coeff. 

Classical 

losses  

coeff. 

Loss in 

excess 

coeff. 

Thickness 

of 

lamination 

Stacking 

factor 

CHARACTE

RISTICS 
SLIP STATOR 363 4.7393 e6 16.2 0.65 e-3 0.97 

Continued on next page 
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Result for a slip 

value equal to 

0.019 

In the data tree, in the Post processing directory, edit the result PM_0_019. 

 

The following results appear:  

 

Name of 

the result 

Result 

Average iron losses 

(over a period) (W) 
Values 

PM_0_019 Total  50.17 W 

By hysteresis 13.71 W 

Classical by eddy currents 6.23 W 

In excess 30.23 W 

 
Technical note The iron stator losses for the modelled part (1/4 of the motor) are 50.17 W. 

The total core loss for the whole motor is 200.6 W. 
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4.3.3. Create I/O parameter 

 
Goal Create some I/O parameter to help the user to carry out a power balance. 

 
Data The characteristics of the I/O parameter are described in the table below. 
 

I/O parameters defined by a formula 

 
Name Comment Expression 

PERIODICITY 
Periodicity of the 

machine 
4 

FREQ Frequency 50 

MECHANICAL_

LOSSES 

Mechanical 

losses 
554.0  

PABS 
Absorbed  

power 
- PowerP(V1) - PowerP(V2) - PowerP(V3) 

SABS 
Absorbed 

apparent power 
PowerS(V1) + PowerS(V2) + PowerS(V3) 

 

To create PABS and SABS parameters, write 

the formula directly in the Expression area. 

See the note at the end of section.  
 

Name Comment Expression 

SPEED Angular Velocity (1-SLIP) * FREQ *60 / (POLES/2) 

I_STA Stator Current  Mod(I(B1) / sqrt(2)) 

COS_PHI Cos ϕ PABS / SABS 

PTR 

Power 

transmitted to the 

rotor 

PABS - PJCS 

PJR 
Joules Rotor 

Losses 
SLIP * PTR 

PU Shaft power (1-SLIP)*PTR-MECHANICAL_LOSSES 

TORQUE Util Torque  PU/(2*pi() * FREQ / (POLES/2)) 

EFFI Efficiency 
100*(PU/(PABS+(PERIODICITE* 

BERTOTTI_LOSSES))) 
 

 Advanced → Parameter I/O → New  
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Remarks To perform the power balancing, PTR, the power given to the rotor part is 

calculated with the following formula :  

JCSABSTR PPP −=  

Consideration on equivalent electric circuit give joule rotor losses  : 

TRJR PgP *=  

In Flux, Iron Losses are calculated at posteriori - during the processing stage. 

As a result, these are only taking in count at the end of calculation of the 

power balancing (see parts relative to this determination).  

 
About PowerP 

and PowerS 

functions 

Functions PowerP and PowerS are postprocessing functions; these functions 

are available via the command Compute on Physic entity, but these functions 

are not directly available via the command Parameter I/O / New. 

To create the PABS and SABS parameters, the user can proceed in different 

ways: 

• write the formula directly in the Expression area as described above 

• recover the python command in the buildPhys.py file (included with 

examples) 
VariationParameterFormula 

(name='PABS',formula='-PowerP(V1)-PowerP(V2)-PowerP(V3)') 

VariationParameterFormula 

(name='SABS',formula='PowerS(V1)+PowerS(V2)+PowerS(V3)') 

• write the complete formula (with using the formula editor) with the 

following information (in the user guide) 

 

Usual global quantities 

(Electric component) in SSACM 

Flux 

name 

Flux 

unit 
Explanation 

Voltage (magnitude) U V  

Current (magnitude) I A  

Apparent power PowerS VA 







= *IU

2

1
ModCPowerS  

Active power PowerP W 







= *IU

2

1
alRePowerP  

Reactive power PowerQ VAR 







= *IU

2

1
ImPowerQ  

 
PABS =-PowerP(V1)-PowerP(V2)-PowerP(V3) 

PABS =-Real(U(B1)*Conj(I(B1)/2)) 

-Real(U(B2)*Conj(I(B2)/2)) 

-Real(U(B3)*Conj(I(B3)/2)) 

 

SABS =PowerS(V1)+PowerS(V2)+PowerS(V3) 

SABS = ModC(U(B1)*Conj(I(B1)/2)) 

+ModC(U(B2)*Conj(I(B2)/2)) 

+ModC(U(B3)*Conj(I(B3)/2)) 
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4.3.4. Steady state rated-load characteristics 

 
Goal  Characteristics of the motor for steady state rated-load operation. 

 
Data (1) The characteristics* of the computation step are presented in the table below. 

 
Scenario and computation step selection 

 
Scenario 

Computation step 

Parameter name Value 

CHARACTERISTICS SLIP 0.019 

 
* These characteristics are located in the dialog box below the data tree. 

 
Data (2) The characteristics of the computation (motor for steady state rated-load 

operation) are presented in the table below. 

 

Compute on physic entity 

 
Name 

Computed formula  f() 
 Expression 

COMPUTEPHYSIC_1 

SPEED 

I_STA 

TORQUE  

COS_PHI 

 

   
Result The result of the computation is presented below. 

 

Physical quantities 
Results of computation 

Label Value 

Angular speed (tr/mn) SPEED 1471.5 

I stator (A)  I_STA 11.79 

Torque (N.m) TORQUE  30.77 

Power factor COS_PHI 0.73 

 
Action Do not forget to store the result of computation COMPUTEPHYSIC_1. 

 

 Computation → On  physical entity → Compute  
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4.3.5. Power balance and efficiency for rated value 

  
Goal  In this part, we propose to determine the machine’s efficiency using the above 

results. By using an equivalent electrical circuit, there is a very easy way to 

calculate the joule rotor losses 

 
Data (1) The characteristics of the computation are presented in the table below. 

 

Compute on physic entity 

 
Name 

Computed formula  f() 
 Expression 

POWER_BALANCE 

PABS 

PJCS 

PERIODICITE* 

BERTOTTI_LOSSES 

PJR 

MECHANICAL_LOSSES 

PU 

EFFI 

 

   
Result The result of the computation is presented below. 

 

Physical quantities 
Results of computation 

Label Value 

Input Electrical Power PABS 6034 W 

Stator Joules Losses  PJCS 540.8 W 

Total Stator Core Losses  
PERIODICITE* 

BERTOTTI_LOSSES 
200.7 W 

Rotor Joule Losses (Pjr) PJR 104.3 W 

Mechanical Losses (Pm) 
MECHANICAL_LOSSE

S 
552.4 W 

Output Mechanical Power (Pmec) PU 4836.48 W 

Efficiency
 FeABS PP

PU

+  
EFFI 77 % 

 
Action Do not forget to store the result of computation POWER_BALANCE. 

 

 Computation → On  physical entity → Compute  
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4.3.6. 2D Curve of the power balance  

 
Goal The values of the power balance versus the rotor slip are computed and 

displayed in a curve. 

 
Data The characteristics of the curve are presented below. 

 

2D curve (I/O parameter) 

 

Name  

I/O Parameter on the abscissa Formula on the ordinate  

Parameter 

name 

Lower 

endpoint 

Upper 

endpoint 
 f()  

POWER_BALANCE SLIP 0.001 0.05 

PABS 

I_STA 

PJCS 

PERIODICITE* 

BERTOTTI_LOSSES 

PTR 

PJR 

PU 

TORQUE 

EFFI 

 

 
Curve → 2D Curve (I/O parameter)→ New 2D Curve (I/O 
parameter)  

Continued on next page 
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Result The 2D Curve of the losses, torque and Efficiency are shown below. 
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4.3.7. Display isovalues of magnetic flux density 

 
Goal The magnetic flux density is computed on the device (excluding vacuum 

regions) and isovalues are displayed in color shadings. 

 

Action Display isovalues (2_ISOVAL_NO_VACUUM) 

 

 Graphic → Isovalues → Display isovalues 
 

 
Result The following chart shows the isovalues of the magnetic flux density on the 

device. 
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4.3.8. Display isovalues of current density in rotor bars 

 

Goal Compute and display isovalues of the current density in rotor bars. 

 

Data (1) The characteristics of the new spatial group are presented below. 
 

Spatial Group 

 
Name Comment 

Spatial group 

Type Volume regions 

GROUP_ROTOR_

CAGE1_BAR 

Spatial 

group 

Volume 

regions 

ROTOR_CAGE1_BAR1 

… 

ROTOR_CAGE1_BAR7 
 

 Support → Spatial group → New  

 

Data (2) The characteristics of the isovalues are presented below. 

 

Isovalues on face regions 

 
Name 

Support for isovalues Quantity 

Support Groups Quantity Formula 

ISOVAL_ 

I_BAR 

Spatial 

group 

GROUP_ROTOR_

CAGE1_BAR 

Current density –

Vector [A/m2] 
J 

 

 Graphic → Isovalues → New  

  

Result The following chart shows the isovalues of the current density on the bars for 

rated-load operation (s = 0.019). 
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5. Case 3: Transient Analysis - No load case 

 
Case 3 The no load state is now computed with the transient magnetic application.  

 
Starting Flux 

project 
The starting project is the Flux project CASE2_SOLVED.FLU. This project 

contains: 

• the geometry description of the device 

• the mesh 

• the initial physical description of the motor 

• the case2 solved 

  
New project All the CASE2_SOLVED results are deleted. The Flux project is then saved 

under the name of CASE3.FLU. 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Case 3: define the physics 65 

Case 3: solve the project 73 

Case 3: result post processing 75 
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5.1. Case 3: define the physics 

 

 
Contents This section contains the following topics: 

 

Topic See Page 

Define the physical application  66 

Modify a mechanical set 67 

Create I/O parameters 68 

Import a created circuit 69 

Modify characteristics of electrical components 70 

Modify face regions 71 

Modify coil conductors face regions 72 
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5.1.1. Define the physical application 

 
Goal The choice of the physical application determines the set of options available 

to the user in terms of physical properties.  

  
Data  The characteristics of the application are presented in the table below. 

 

Rotating Machine (Skewed Model) in Transient Magnetic 
 

Physical Definition 
 

Skewed  

rotor or stator 

Multilayer 

model 

Elevation 

in meter 

Angle of 

rotation (deg.) 

Number of slices 

in the elevation 

Rotor with 

skewed slots 

Multilayers 

2D model 
0.14 10.23 5 

   

Coil Coeffcient 

 Automatic coefficient (Symmetry & Periodicity take into account) 
 

Transient initialization 

 With zero initial solution (variables set to 0) 

 

 Application → Delete current application 

 

 
Application → Define→ Magnetic → Rotating Machine (Skewed Model) 
in Transient Magnetic 
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5.1.2. Modify a mechanical set 

 
Goal  The study of the no load state is performed using the Imposed speed 

kinematic model 

 
Data The characteristics of the MS_ROTOR mechanical set are presented in the 

table below. 
 

Rotation around one axis mechanical set 

 

Name Comment 

Axis Kinematics 

Rotation 

axis 

Coord. 

system 

Pivot point coordinates Type of 

kinematics 1st 2nd 

MS_ROTOR 
Movable 

part 

parallel to  

Z-axis 
XY1 0 0 

Imposed 

Speed 

 

 

 

Kinematics (continued) 

 General Internal characteristics 

Velo 

city 

Position 

t = 0 s 

Type of load Moment of 

inertia 

Friction coef. 

Cst  Viscous  Friction  

1500 0 

Inertia, 

friction coeff. 

and spring 

0.4936 0 
3.927 

e-4 
0 

 

 Physics → Mechanical set → Edit  
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5.1.3. Create I/O parameters 

  
Goal Three new I/O parameters will be created in order to define the physics. 

 
Data (1) The characteristics of the I/O parameter are described in the tables below. 

 
I/O parameters defined by a formula 

 Name  Expression 

SPEED 1500 

FREQ (SPEED/60)*(POLES/2) 

OMEGA 2*Pi()*FREQ 

 

 Parameter / Quantity → I/O parameter → New 
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5.1.4. Import a created circuit 

 
Action Import the .xcir circuit named « InductionSkewedMotor.xcir ». 

 

 Physics → Circuit → Import a circuit from a .xcir file   

 
Result The following circuit is integrated in the project and the circuit components 

appear in the Data tree.  
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5.1.5. Modify characteristics of electrical components 

 
Goal  The circuit is modified in Flux in order to describe the physics. 

 
Data (1) The characteristics of the voltage sources are described in the table below. 

 
Voltage source by formula 

 Name  Value [V] 

V1 VRMS * Sqrt(2) * sin(OMEGA*TIME) 

V2 VRMS * Sqrt(2) * sin(OMEGA*TIME – 2*pi()/3) 

V3 VRMS * Sqrt(2) * sin(OMEGA*TIME + 2*pi()/3) 

 

 Physics → Electrical components → Voltage source → Edit 

 
Data (2) The characteristics of the stranded coil conductors are described in the table 

below. 

 
Stranded coil conductors belonging to a circuit 

 Name Resistance formula [Ohm] 

B1, B2, B3 1.29568 

  

 Physics → Electrical components → Stranded coil conductor → Edit 

 
Data (3) The characteristics of the inductors are described in the table below. 

 
Inductor 

 Name  Inductance [Henry] 

L1, L2, L3 1.408 e-3 * 4 

  

 Physics → Electrical components → Inductor → Edit 

 
Data (4) The characteristics of the squirrel cage are described in the table below. 

 
Squirrel cage 

 

Number of bars  7  

Resistance of the portion of end rings between 

two adjacent bars  
4.7e-7 Ω 

Inductance of the portion of end rings between 

two adjacent bars  
5.3e-9 H 

 

 Physics → Electrical components → Squirrel cage → Edit 
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5.1.6. Modify face regions 

  
Goal  Face region are edited and modified in order to describe the physics. 

  
Data The characteristics of the face regions used to describe the materials are 

presented in the table below: 

  
Face region 

ypp Name Type  Component Mechanical set 

STATOR Magnetic non conducting  FEV_1000 MS_STATOR 

ROTOR Magnetic non conducting FEV_1000 MS_ROTOR 

 
Face region 

pp 
Name Type  

M
a

te

ria
l 

C
i

rc

u
it 

/ 

N
o

 

cir

cuit 

Associated solid  

conductor 

O
r

ien
t

a
ti

o
n

 

Mec

h
an
i

ca
l 

set 

ROTOR_CAGE1_

BAR1 

Solid 

conductor 
Copper Circuit 

BAR_1_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR2 

Solid 

conductor 
Copper Circuit 

BAR_2_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR3 

Solid 

conductor 
Copper Circuit 

BAR_3_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR4 

Solid 

conductor 
Copper Circuit 

BAR_4_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR5 

Solid 

conductor 
Copper Circuit 

BAR_5_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR6 

Solid 

conductor 
Copper Circuit 

BAR_6_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

ROTOR_CAGE1_

BAR7 

Solid 

conductor 
Copper Circuit 

BAR_7_SQUIRRE

LCAGE_1 
Positive MS_ROTOR 

 
Face region 

 Name Type  Mechanical set 

INFINITE Air or Vacuum region MS_STATOR 

PRESLOT Air or Vacuum region MS_STATOR 

ROTATING_AIRGAP Air or Vacuum region MS_STATOR 

STATOR_AIR Air or Vacuum region MS_STATOR 

WEDGE Air or Vacuum region MS_STATOR 

ROTOR_AIR Air or Vacuum region MS_ROTOR 

SHAFT Air or Vacuum region MS_ROTOR 

 

 Physics → Face region → Edit   
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5.1.7. Modify coil conductors face regions 

 
Goal  Three face regions are modified in order to describe the physics. 

  
Data  The characteristics of the face regions are described in the table below. 

 
Face region 

 

Name Type  

C
o

m
p

o
n

en
t 

T
u

rn
 

n
u

m
b

er 

O
rien

ta
tio

n
 

S
eries / 

P
a

ra
llel 

Symetries 

and 

periodiciti

es 

Mechanical 

set 

PHASE_POS_1 

Coil 

conductor 

region 

B1 80 Positive 
All in 

series 
In series MS_STATOR 

PHASE_POS_2 

Coil 

conductor 

region 

B2 80 Positive 
All in 

series 
In series MS_STATOR 

PHASE_NEG_3 

Coil 

conductor 

region 

B3 80 Negative 
All in 

series 
In series MS_STATOR 

 

 Physics → Face region → Edit  

 
Action Check physics and save case 3. 

 

 Physics → Check Physics    

 

 Save Case3   
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5.2. Case 3: solve the project 

 

 
Goal  A solving scenario is created in order to solve CASE3. Then CASE3 is solved 

with modified solving options. 

 
Data (1) The characteristics of the scenario used to solve CASE3 are presented in the 

table below: 

 
Solving scenario 

 
Name Type 

Lower 

limit 

Upper 

limit 

Variation 

method 

Step 

value 

TIME_PARAM 
Control by 

time 
0 0.12 Step value 4 e-4 

 

 Solving → Solving scenario → New  

  
Data (2) The characteristics of the solving process options are presented in the table 

below: 

 

Solving process options for non linear system solver 

 
Precision 

Max number of 

iteration 

Method to compute 

relaxation factor 

1.0 e-4 100 Fujiwara method 

 

 Solving → Solving process option → Edit  

 
Action Solve and save the project under the following conditions: 

• Solve with: scenario TIME_PARAM 

• Project name: CASE1_SOLVED 

 

 Solving → Solve 
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5.3. Case 3: result post processing 

 

 
Introduction This section explains how to analyze the principal results of CASE3. 

 
Contents This section contains the following topics: 

 

Topic See Page 

Display isovalues of magnetic flux density 76 

2D Curve of current through the different coils 77 

2D Curve of torque versus time 79 

 



Case 3: Transient Analysis - No load case  Flux 

PAGE 76 Induction motor with Skew tutorial  

5.3.1. Display isovalues of magnetic flux density 

 
Goal The magnetic flux density is computed on the device (excluding vacuum 

regions) and isovalues are displayed in color shadings. 

 
Action Display isovalues (ISOVAL_NO_VACUUM) 

 

 Graphic → Isovalues → Display isovalues 
 

 
Result The following chart shows the isovalues of the magnetic flux density on the 

device. 
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5.3.2. 2D Curve of current through the different coils  

 
Goal The values of the current through the different coils versus time are computed 

and displayed in a curve. 

 
Data (1) The characteristics of the curve are presented below. 
 

2D curve (I/O parameter) 

 

Name  

I/O Parameter on the abscissa Formula on the ordinate   

Parameter 

name 

Lower 

endpoint 

Upper 

endpoint 

Electrical 

component 
Quantity Formula 

STATOR_ 

CURRENT 
TIME 0.0 0.12 

B1 Current [A] I(B1) 

B2 Current [A] I(B2) 

B3 Current [A] I(B3) 
 

 
Curve → 2D Curve (I/O parameter)→ New 2D Curve (I/O 
parameter)  

 
Result (1) The stator current versus time over the full analysis is shown below. 

 

 

Continued on next page 



Case 3: Transient Analysis - No load case  Flux 

PAGE 78 Induction motor with Skew tutorial  

 
Data (2) The characteristics of the curve are presented below. 
 

2D curve (I/O parameter) 

 

Name  

I/O Parameter on the abscissa Formula on the ordinate   

Parameter 

name 

Lower 

endpoint 

Upper 

endpoint 

Electrical 

component 
Quantity Formula 

STATOR_ 

CURRENT 
TIME 0.1 0.12 

B1 Current [A] I(B1) 

B2 Current [A] I(B2) 

B3 Current [A] I(B2) 
 

 
Curve → 2D Curve (I/O parameter)→ New 2D Curve (I/O 
parameter)  

 
Result (2) The current versus time over the last period is shown below. 
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5.3.3. 2D Curve of torque versus time  

 
Goal The values of the torque versus time are computed and displayed in a curve. 

 
Data The characteristics of the curve are presented below. 
 

2D curve (I/O parameter) 

 

Name  

I/O Parameter on the abscissa Formula on the ordinate   

Parameter 

name 

Lower 

endpoint 

Upper 

endpoint 

Mech. 

set 
Quantity Formula 

STATOR_ 

CURRENT 
TIME 0.0 0.12 

MS_ 

ROTOR 

Electromagnetic 

torque 

TorqueElecMag 

(MS_ROTOR) 

 

 
Curve → 2D Curve (I/O parameter)→ New 2D Curve (I/O 
parameter)  

 
Result The 2D Curve of the stator current versus is shown below. 
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7. Annexe 

 
Contents This chapter contains the following topics: 

 

Topic See Page 

Mechanical Data 83 

Circuit Data 89 
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7.1. Mechanical Data 

 
Contents This section contains the following topics: 

 

Topic See Page 

Determination of mechanical losses and friction coefficient 84 

Determination of inertia 86 
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7.1.1. Determination of mechanical losses and friction coefficient 

 
Introduction  We suggest a method below to calculate the losses by friction and ventilation 

and thus the coefficient of viscous frictions and the resistive torque. These 

parameters supplement the essential mechanical equation for the modeling 

and the simulation of the motor in startup mode. 

The test corresponds to a no-load test in rotation. The phases of the stator 

winding are supplied by an alternating voltage source. Because the induction 

machine does not involve a mechanical load, the useful output is null. The 

machine thus functions in no-load mode. There is, however, a very low value 

of resistive torque, equivalent to the losses by friction and ventilation. Thus 

the slip is not completely null. As 0=uP  then Vfmeca pP +=  and 0g . 

 
Operation 

description 
We measure:  

• The phase to phase voltage 0U  

• The line current 0I  

• The absorptive power 0P  

• The no-load speed to make sure that the value of the slip is low. 

 

The absorptive current 
0I  is primarily limited by the stator impedance and 

the magnetizing impedance. Since the useful power is null, the absorptive 

power 0P  represents the sum of the following losses: 

• Ohmic losses due to the no-load current 0I : 2
03 IRs  

• The iron losses: 
Ironp  

• The mechanical losses due to frictions and ventilation: vfp +  

vfIrons ppIRP +++= 2

00 3    (22) 

Knowing by measurement the values of 0P , sR  and 0I , we can determine the 

sum of the iron, friction and ventilation losses: 

vfIrons ppIRP ++=− 2

00 3  

 

To differentiate these two losses, it is necessary to take measurements for 

various voltages included between nU2.0  and nU2.1 . 

The mechanical losses are roughly constant as long as the rotation speed does 

not vary too much. 

The iron losses vary with the square of the voltage applied at the boundaries. 

By tracing the variation of 2
00 3 IRP s−  according to 2

0U , one obtains the 

characteristic shown in Figure 1, which is a line that one extrapolates until 

00=U . The corresponding ordinate is equal to the losses by friction and 

ventilation. In effect, with null tension, the losses irons are null. 

 

Continued next page 
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Figure 
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Figure 1 :  P_iron + P_meca = f(U²) 

 
Results 

obtained 
In our case we obtained: 

Wp vf 4,552=+  

 

As 

0= ++ vfvf Cp  

 

and 

0=+ fC vf  

 

then the friction coefficient is given by 

 
122

0 ...10.25,2 −−

+ == radsmNpf vf  
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7.1.2. Determination of inertia 

  
Introduction Simulations in coupled load also require the user to enter certain mechanical 

data, such as the inertia and the friction coefficient. 

The aim of this section is to provide the user with analytical and experimental 

methods to determine the values of the parameters essential to the 

development of a model. 

  
Operation 

descritpion 
The determination of the inertia of the induction machine is done by 

measuring the speed according to the time of deceleration (see Figure 2). 

The studied machine is brought to a speed approximately 20% higher than the 

nominal speed by means of a DC machine. Then when the power of the DC 

drive machine is cut, the studied machine slows down under the effect of the 

involved losses: the total mechanical losses of the group. 

The time of deceleration depends on inertia and also on the involved losses. 

The equation of motion gives: 

rM
dt
dJ =      (20) 

where 

• J   Inertia (kg.m2) 

• rM  Resistive torque due to losses (N.m) 


=
Losses

M r
 

•   Angular velocity (rad.s-1)  
60

.2 n=  

 

With the preceding expression, inertia can be calculated by: 

t

Losses

dt

d

Losses
J











=


..

   (21) 

where t  represents the slope of the tangent to the curve of deceleration 

at point A. Point A corresponds to the point where the speed is nominal, 

because it is at this speed that the losses are known. 

 

Continued next page 
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Numerical 

application 
             nom   1.09,154 −= srad  

              1.7,199 −= srad  

t      s5,27=  

   mécap W4,552=  

 

 One finds then 

2.4936,0

5.27

7,199
09,154

4,552
mkgJ =



=  and mNM r .58,3
09,154

4,552
==  
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Figure 2: determination of inertia 
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7.2. Circuit Data 

 
Contents This section contains the following topics: 

 

Topic See Page 

Introduction of circuit data 90 

Determination of the end winding impedance 91 

Determination of the end ring impedance 93 
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7.2.1. Introduction of circuit data 

 
 The winding is concentric with consequent poles. It is represented in Figure 3. 

The modeling of induction machines under Flux2D considers only the straight 

section of the geometry (as for SKEW application). Effects relating to the 

parts located at the end of the machine are taken into account by the addition 

of an electric circuit to the model with finite elements. This electric circuit 

integrates the end winding resistance and inductance to supplement the 

modeled part of the stator and the end ring resistance and inductance to 

supplement the modeled part of the rotor. 

In addition simulations in coupled load require the user to enter certain 

mechanical data, such as the inertia and the friction coefficient. 

The aim of this section is to provide to the user analytical and experimental 

methods in order to determine the values of the essential parameter to the 

development of a model. 

  
Figure  
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Figure 3 : Windings 
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7.2.2. Determination of the end winding impedance 

  
Resistance per 

phase 
The resistance per phase due to the end winding is given by 

2

8

wwc

spptppew

ew
dNN

NN
R




= ,   (1) 

where 

•   is the resistivity of a wire ( )m.  

• ew
 is the length of the end winding ( )m  

• tppN
 is the number of turns per slot per phase 

• sppN
 is the number of slots per pole per phase 

• cN
 is the number of coils in parallel per phase 

• wN
 is the number of wires in series per phase 

• wd
 is the diameter of a wire ( )2m . 

 

  
End winding 

length 
The calculation of the end winding length can be obtained by the following 

formulation  

( ) ssssextew hhD
p

22
2

++=


 ,   (2) 

where 

• extD  is the internal diameter of the stator, 

• ssh  is the height of a stator slot. 

 

This first calculation gives an acceptable approximation of the end winding 

resistance. 

 

  
Numerical 

application ( ) mew

222 10.8,1310.45,1210.45,1211,0
22

−−− =++


=


  

=



=

−

−−

147,0
10.06,311

42010.16,910.42,28
6

28


ewR  

 

Continued next page 
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End winding 

reactance 
The end winding reactance is obtained by the following relation 

P
N

NN

p
X

c

tppss

tb

2

0

18 









=


,   (3) 

where 

• ssN  is the number of stator slots 

• 0  is the magnetic permeability of vacuum 

•   is the electrical pulsation relating to stator currents. 

 

P is a parameter which depends on the winding. For a concentric winding 

with non-consequent poles, we have 

apew LP 3.047.0 −=      (4) 

 

for a winding with consequent poles 

apew LP 43.067.0 −=     (5) 

 

where 

( )ssextap hD
p

L +=
2


    (6) 

 

  
Numerical 

application ( ) mLap 09778,00145,011,0
22

=+


=


 

 

mP 0504146,009778,043.010.8,1367.0 2 =−= −
 

 

HLtb

3

27

10.62,10504146,0
1

2048

218

104 −
−

=






 




=


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7.2.3. Determination of the end ring impedance 

  
Figure  

Magnetic circuit 

Bar 

Ring 
rD  iD  

h e 

 

Figure 4: representation of the intersection bar-rings 

 

  
End ring 

resistance 
TRICKEY shows that the end ring resistance can be calculated from the 

following equation 

,   (7) 

 

where the coefficient of correction is given by  









−





























−









+

=
r

i

p

r

i

p

r

i

ring
D

D

D

D

D

D

K 1

1

1

2

2

  (8) 

  
Skin effect With Formulation 7 (above) it is possible to take into account the skin effect, 

which appears in two different ways: 

• the first translates the variation of the useful height 
ph  of the bar, 

• the second corresponds to that occurring in the thickness of the ring. 

 

If the current does not penetrate completely into the width of a rotor bar, one 

understands easily that the diameter rD  to be used ( )réqD  is larger than that 

indicated in Figure 4. 

 

According to the preceding assumptions, one can set the relation 

pextréq hDD −= , hDD iaext +=   (9) 

Continued next page 
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Skin effect 

(continued) 
where the penetration depth of the current in the bars 

ph  can be given 

according to the method suggested by M.M. LIWSCHITZ-GARIK [LIW-55]. 

 

This approach initially requires one to determine the skin effect coefficient in 

the thickness of a bar 

( )
( ) ( )
( ) ( )




2cos2cosh

2sin2sinh

−

+
=    (10) 

 

where 






fs
e 0=   s- slip  (11) 

 

The coefficient must be corrected by a factor K  calculated according to the 

contact surfaces between the bar and the ring. Let 
b

éq

h

h
X =  the relationship 

between these two surfaces: 

• If 36,2X  then 07,108.001,0 2 +−= XXK  (12) 

• If 36,2X  then 977,0017,0 +−= XK   (13) 

 

It follows then 

)
2

( aextext

pb

DD
hh

−
−= ; 





+
=

eR

D
h

a

aext
éq

; 
( )

eK
eéq = ; (14) 

 

where aR is resistance of end ring 















−

+
−=

p

i

p

r

p

i

p

r
ira

DD

DD
DD

eh

p
R

22

22

)(


  (15) 

 

So the useful width of the bar is 

)(

H
hp =      (16) 

Continued next page 
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Figure All of these calculations shown above enabled us to determine an equivalent 

thickness of the ring and a useful width of bar according to the frequency. 

One obtains an equivalent model (which takes into account the skin effect) 

represented in Figure 5. 

 

 

  

Figure 5: representation of the intersection bar-rings with skin thickness 

  
Resistance 

inter-bar 
The resistance of an inter-bar segment is obtained by applying Formula 7 to 

the equivalent ring, remembering to divide the result by the number of bars 

that make up the rotor: 

( )














−

+
−=

p

i

p

réq

p

i

p

réq

iréq

éqr

a
DD

DD
DD

he

p

N
r

22

22
1 

(17) 

  
Reactance The calculation of the reactance is made by applying Formulation 18 to the 

equivalent ring 

( ) aeqaext

r

a hD
N

X 


 −= 0     (18) 

 

( )
( )eqeq

eqaext

a
eh

hD
Log

+

−
=

4

3
365.0


    (19) 

Continued on next page 
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Numerical 

application 
All results obtained are presented in the table below. 

 

 Numerical application:  
 

 

Figure 3: Results 

2=p  Number of pole pairs, 
210.8,1 −=e  Ring thickness ( )m , 

210.8,2 −=h  Ring height ( )m , 

210.45,1 −=H  Slot height ( )m , 

210.7,8 −=rD  Diameter at the bar 

center ( )m , 
210.5 −=rD  Ring lower diameter 

( )m , 

28=rN  Number of rotor slots, 

7

0 104 −=   Magnetic permeability 

( )mH , 

50=f  Current stator 

frequency ( )Hz , 
110.092.1 −=extD  Rotor external 

diameter ( )m  
 

 

  


